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What's On......General Meeting Wednesday 5 June at Caloundra
Technology
Education
Centres
Caloundra
Buderim
Yandina

• Get hands on help with all your technology problems.
• Tutorials are presented during each session.
• Internet and intranet access is available.
Windows, Linux and Apple Mac operating systems are supported.
Every Saturday between 9.00 am and 1 pm
Caloundra Youth hall, Queen Street Caloundra, (opposite High School).
Every Wednesday between 9.30 am and 12.00 noon,
Good Life Centre, 100 Buderim Pines Drive, Buderim.
3rd Wednesday of the month between 1.30 pm and 4.00 pm.,
RSL Hall, North Street, Yandina

Notice about SCCC Monthly General Meetings
Commencing in May 2010 the SCCC Monthly Meetings will alternate between the Caloundra and Buderim venues.
In Caloundra the meeting will be on the first Saturday of the month and in Buderim the meeting will be on the first
Wednesday of the alternate month.
The next SCCC Monthly Meeting will be at Caloundra on Saturday 5 June 2010 at 11.00 am.
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From The Editor - Heather Atkinson
Bits'N'Bytes is produced monthly from February to
December each year.
Contributions for the newsletter are always welcome.
Please send copy for the next issue to reach the editor
as early as possible after the monthly meeting or by the
deadline: 25 June 2010.
Email: editor@sccc.org.au or Snail Mail: The Editor PO
Box 549, Mooloolaba, Qld 4557.
This magazine is created with OpenOffice and
produced in printed form and also electronically
in PDF format.
Copyright - material in this newsletter may be copied
in other publications provided that copyright rests with
the Sunshine Coast Computer Club Inc., This permission
is on condition that reference is made to SCCC (with
original published date) in the reprinted item.
Liability - Although articles in this newsletter are
checked for content, no warranty can be given for any
loss resulting from the use of material in the newsletter.
Articles and advertisements are printed in good faith
and views and opinions are not necessarily those held
by the club.
SCCC Privacy Statement - In joining the Sunshine
Coast Computer Club please note that it is a club
operated by volunteer members and operating within
the community involving many activities relating to
meetings, instructional and social functions for
members and at times visitors.

This requires the keeping of a member data base and
the publication of the names of new members. The
Club guards the member data base as best as possible
and does not publish member's addresses nor
telephone numbers unless authorised.
At times photographs are taken at meetings and
functions and are sometimes published. Should you
have any problems relating to your personal privacy
which arises or is likely to arise, it is your duty and
responsibility to advise the Club secretary in writing of
the circumstances and requirements.
What's on Bulletin - What's On Bulletins are sent once
a week, generally on a Monday afternoon, to all members
who have provided the Club with their email address.
These bulletins give details of up-coming tutorials and
topics to be covered at the various meeting venues. You
will also find items of interest and club announcements in
these bulletins.
Membership Cards for Collection - Membership
cards for those members who joined or renewed
membership
for
the
month
ending 20 January 2010 are available for collection at
Caloundra and Buderim meetings. Cards that have not
been collected in the previous twelve months are also
available.
Note - Membership cards show the next renewal date
of membership.

Raffles
Congratulations to Frank McAllister who won the $200 Gift Voucher which was drawn at the Caloundra
Meeting on Saturday 22 May 2010 using the Random Number Generator. The winning ticket was number 53.
The next SCCC Raffle will be drawn at the Buderim Meeting on Wednesday 30 June 2010.

Win a 750 GB My Passport Essentials Hard Drive
This portable hard drive will store a massive amount of data and features
automatic, continuous backup and password protection.
There is also a fifty dollar gift voucher to be won. Hand the Voucher back to the
Club and receive fifty dollars cash to spend where ever you like.
Tickets are only one dollar each and are available at all meetings.
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Treasurer's Report
Income and Expenditure
21 April 2010 – 20 May 2010

Income
Donation
Fundraising
Interest
Meetings
Membership fees
Sales
Total Income
Expense
Administration
Hall Hire
Internet Service Provider
Library Expenses
Office Supplies
Postage
Printing/Stationery
Refreshments and Entertainment
Software Puchases
Repairs and Replacements *
Travel re-reimbursement
Website Expenses
Total Expense
Excess of Expenditure
over Income

Accepted, was Seconded by Ann Karmann. CARRIED

11.82
360.92
17.89
2530.91
2038.29
20.91
4980.74
600.00
1,300.00
13.59
133.52
18.18
68.15
403.64
431.98
180.91
4584.41
28.71
151.82
7914.91
-2934.17

* Includes 23" Monitor, 2 Data Projectors and 22 Tables
Minutes of the General Meeting
Held at The Good Life Centre Buderim
5th May 2010

General Business: Peter confirmed that at the last
meeting the members decided that the excess funds we
have, should be spent on services for the club. We have
purchased new data projectors for Caloundra and
Buderim, and tables for Caloundra, and many other
purchases which will be published in the club magazine.
Lots of things have already been implemented including
the new PA system for Buderim although this still needs
some fine tuning. Peter said that what we needed to
discuss today was the issue of Training. We are putting
in place more areas where a few people can sit down in
front of a monitor, with a trainer, but should we be
training the trainers. Heather said she would like to see
this implemented, where volunteer trainers could attend
TAFE courses, that would qualify them to conduct
courses within the club, that would provide members
with a certificate at the outcome to say the course had
been completed. Peter suggested that a bulletin be put
out to test the level of interest before we decide on
professional training. We would also have to look at the
cost of training volunteers, and putting in place
contracts to ensure the trainers remain in the club.
More discussion would be needed on this subject. He
also suggested that workshops be held within the club
to help presenters fine tune their skills. Another option
would be to develop the club website, where members
have access to online courses and have volunteers
trained to answer their questions.
A Motion was proposed by Robin Cameron that we do
not bring in paid professional trainers, this was
seconded by John Pollett. CARRIED

Meeting: Commenced: 11.00 am
Apologies: None
Minutes of Previous Meeting: No Business arising
from the previous minutes, A Motion proposed by
Denise King, that the previous months minutes be
accepted was Seconded by John Pollett, CARRIED
New Members: Randal and Maude Berry, Joan
Coppins, John Fengler, George Hanslow, Elaine Hewitt,
Lorraine Heath, Jean Hughes, Maureen Jefferies, Jean
Liset, Billie Nixon, Peter Smart, Pauline Timms, Yvonne
Weekes.
Treasurers Report: Heather Atkinson presented the
Treasurers Report for the period 21/03/10 to 20/04/10.
Over this period we have bought five new laptop
computers, other expenditure was normal, most of the
money being spent on hall hire, and printing. The cost
of the new data projectors will appear in next months
financial report. The Treasurers Report is published
each month in the Bits'N'Bytes. A Motion proposed by
Heather Atkinson that the Treasurer's Report be

A Motion was proposed by Udo Heuermann that we do
not provide a bursary for a Student was seconded by
Jim McGregor CARRIED
A Motion proposed by Ann Karmann that we do not pay
outside volunteers to do presentations was seconded by
John Pollett. CARRIED.
General consensus was that we should put more effort
into training our own presenters and provide more
areas where people can get basic help.
We will purchase two copies of the latest Microsoft
Office one each for Buderim and Caloundra, to help
members using this programme.
The next general meeting will be held in Caloundra
when we will be discussing Finances.
Peter declared the meeting closed at 11.40am.
Marie McGregor (Secretary)
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Set Up an Entertainment Centre by President Peter Daley
It is very easy to set up an exciting home
entertainment centre on your personal computer, plus
you can do it for little cost, or for free. Why purchase all
those extra boxes, e.g. DVD player / recorder, Video
Recorder, Desktop High Definition TV box, Radio, CD
player, and Hi-Fi system, plus have all those messy
cables lying around, when you can do everything neatly
in one box, your computer?
Yes, you can go and purchase a dedicated home
entertainment centre computer if you want, but why
would you, when all you need is a modern computer
system, no more than two years old, with a reasonable
video card and 80 GiG or larger hard drive, with a
minimum of 512 megs of RAM, and install one of the
excellent free home entertainment software packages,
that will turn your computer into a sophisticated home
entertainment centre.
For Windows based systems you install the free home
entertainment software program, Media Portal,
http://www.team-mediaportal.com/
For Linux use Myth TV, http://www.mythtv.org/
Both these programs will turn your home computer into
an advanced home entertainment media centre. They
will organise and play all your media files, music, radio,
and allow you to watch your stored video, and DVDs,
even display the local weather report. They also turn
your computer into a recorder for your TV and Digital
video.
To use the Radio, TV or scheduled TV recording
features, you will need to install a High Definition or
Analog TV/Radio tuner card into your home computer,
or use an external USB TV High Definition or Analog
tuner plug-in device. These cost from $100 upwards.
Dual tuner cards will allow you to watch one station,

and record another at the same time.

(Tip: If you are using Linux, make sure you check out
which TV tuners will work with Myth TV before
purchasing a device.)
I personally prefer the USB tuners, because you can
move them from one computer to another, with ease. If
you have multiple computers in the house, you can turn
any one of them into a High Definition TV
player/recorder, by simply installing the USB device’s
software on each machine, and then plug in the USB
tuner into the computer you wish to use as a TV set at
that time.

(Tip: make sure you purchase a TV Tuner card, or USB
TV, with good signal sensitivity.)
In most areas you will need to plug the TV/Radio tuner
device into an external roof mount aerial, to get good
reception. An important point that will greatly improve
the enjoyment and usability of your home
entertainment centre, is to have all your entertainment
media, music and videos, organised in a logical sensible
fashion, in your computer filing system, before you
install the media centre software.

(Tip: Make sure you do regular backups of all your
multimedia files!)
During the installation process, these programs will
search your hard drive and index all your stored media
files as you have organised them on your computer. So
it doesn’t matter how good the media centre software
is, it’s ease of use will be determined by how logically
you have organised your media files on your computer.
© Peter Daley 2010

As I Mature
I have learned that you cannot make someone love you. All you can do is stalk them and hope they panic
and give in.
I have leaned that it takes years to build up trust, and it only takes suspicion, not proof, to destroy it.
I have learned that we are responsible for what we do, unless we are celebrities.
I have learned that the people you care most about in life are taken from you to soon and all the less
important ones just never go away.
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Impress Presentation Tutorial by Heather Atkinson
Impress is the presentation program included in the
free OpenOffice office suite.
This is what openoffice.org has to say about it:
"IMPRESS is a truly outstanding tool for creating
effective multimedia presentations. Your presentations
will stand out with 2D and 3D clip art, special effects,
animation, and high-impact drawing tools.

You may choose to create an interactive presentation
which requires input from the viewer, such as clicking
with the mouse to proceed to the next slide, or have
your presentation automatically progress through the
slides.

Master Pages simplify the task of preparing your
materials. Save even more time by downloading
templates
from
our
Extensions
repository
(http://extensions.services.openoffice.org/templates).
A complete range of Views are supported: Drawing /
Outline / Slides / Notes / Handouts to meet all the
needs of presenters and audiences, plus an optional
multi-pane view to put all the tools at your fingertips.
IMPRESS supports multiple monitors, so that
presenters can look at something else while presenting
their slides on a projector. Make the most of this With
the free Presenter
Console
Extension,
(http://extensions.services.openoffice.org/project/prese
nter-screen) which lets you see your next slides as well
as the time and the speaker notes.
IMPRESS has a complete range of easy-to-use drawing
and diagramming tools to spice up your presentation.

Let's create a simple interactive educational game for
kids. It is called ABC and requires the child to progress
through the alphabet and match the correct word to
describe an image. Thanks to Jim Haxton for this idea.
From the Presentation Wizard select
Presentation" and then click "Create".

"Empty

'Park' your most commonly used drawing tools around
your screen ready for single-click access.

Click on the "Tasks" panel from the resulting screen
and choose "Master Pages" and select the appearance
of the page you like.

Slide show Animation and Effects bring your
presentation to life. Fontworks provides stunning 2D
and 3D images from text. Create lifelike 3D images
with astounding speed and response.

Click on "Layouts" and choose the layout closest to
what you want. It can be edited later. I chose the
"Title, Clipart, Text" layout. Hover your cursor over the
thumbnails to see a description.

Save your presentations in OpenDocument format, the
new international standard for office documents. This
XML based format means you're not tied in to
IMPRESS. You can access your presentations from any
OpenDocument compliant software.

Double click in the image place-keeper to add a saved
image.

Of course, you are free to use your old Microsoft
PowerPoint presentations, or save your work in
PowerPoint format for sending to people who are still
locked into Microsoft products. Alternatively, use
IMPRESS's built-in ability to create Flash (.swf) versions
of your presentations."

Click in the text place-keeper areas to add text. Try a
right click to see the context menu. Amongst other
options, you will be able to edit the style including font
type and size

Note: You will get different right click context menus
depending on where you click. If you click within the
text box you will get different options than if you click
on the text box border (so that you see the eight
handles around the box).

When you first start Impress, you will be presented
with a wizard which will step you through setting up
the style and behaviour of your presentation. If you do
not want this wizard to appear every time you start the
program you can tick "Do not show this wizard again".
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Passwords by Bill Maxwell
This question was actually asked of me recently when I
configured a new computer. I strongly suggested that
the primary user create a new and unique user name
and password for her Westpac Account, one that no
one could possibly guess, and I advised her to not write
it down anywhere. How in the heck am I supposed to
remember it, she asked? It got me thinking about how
reliant we are on passwords, how often we use them,
and how vulnerable we are because of them.
What are the most common passwords? Password,
12345, qwerty, and so on, are pretty common. Your
kid’s or spouse’s name, your pet’s name, and such are
also pretty common. I suppose that’s because these are
so easy to remember. However, they’re also easy for
busybodies, thieves, cheats, and swindlers to guess.
Identity theft has become one of the most common
crimes in today’s technological world, and easy
password theft plays a big part in that. Passwords are
used for any number of purposes.
E-mail account passwords, a second or third e-mail
accounts password, document passwords, server log-in
passwords, application management passwords,
application user passwords, FTP site passwords, Web
site passwords, vendor Web support passwords, ecommerce passwords (such as eBay, PayPal, and online banking), WIFI passwords, and the list goes on and
on. One can’t possibly use a unique password for each
and every case, much less change it periodically — all
without writing it down. Yeah, right.
Here’s the advice I gave to the user who asked me how
to remember passwords.
For the relatively benign types of uses, I’ll use
something easy to remember, and one I’ll never
change. Something like a name or easily remembered
number. For example, when Hewlett Packard,
Download.com, the Los Angeles Times, or some other
vendor requires a user name and password to
download a driver or access some content, it’s always
the same one.
Example: User Name: MickeyMouse46
Password: DonaldDuck
I couldn’t care less if someone else knows what it is.
What’s the worst that can happen? They download
hundreds of drivers in my name? Who cares? For these
types of things, I use the same one over and over
again, I never change it, and I never will. If I have to
go to that vendor Web site only once every couple of
years, I don’t have to rack my brain remembering its
own unique password.

One tip: When creating a user account on a web page
such as Yahoo or Download.com, DO NOT give them
your real name or date of birth. Create a pseudonym
and use it. This will help protect you from Identify
Theft.
DO NOT use your main email account. Create a Yahoo
or Gmail account and give them that email address. Use
your pseudonym when you create these accounts.
For things that might be of little consequence if
someone guessed it, but I wouldn’t really want it to
happen, I’ll use a different password. The worst that
can happen is that someone stumbles upon it and
causes a mild disruption, but it couldn’t really do any
significant harm. I might change this password from
time to time, but certainly not on a regular basis. My
TechRepublic password, for example, is something
that’s meaningful to me, something that I’ll not forget,
but it’s not unique. I use the same one for several sites.
For uses that are very personal and private, ones that
could have serious repercussions if anyone ever gained
access, like Westpac or Paypal, I do indeed follow the
standard advice. This is what I told the user who asked
me, because hers was such a case. I do indeed change
them from time to time, probably about twice a year,
and I never write it down. I make it extremely difficult
for anyone to guess (or a program to hack), and I use a
combination of numbers, characters, and letters, both
upper and lower case. And to make it easy for me to
remember, I pick something meaningful to me, but
arrange it in such a way to be meaningless to others.
For example, I might remember Central High School
class of 1964 and create the password CenHS-co64.
Or I’ll remember the make and model of my first
girlfriend’s car — the one I put a nasty scratch on, and
the incident over which her father almost killed me!
Remembering that 1965 Thunderbird might result in a
password, Tbird65+IstGF. How could I ever forget that
car? It was a pink convertible with a 300 horsepower
390 Cubic Inch V8 engine.
If you have two kids, Mary and Billy, aged 16 and
12, respectively, you might be able to create a
password, 2k-Ma16&Bi12.
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Package Management by Tony Tasker
Any distribution, Windows or Linux, includes many
applications for performing common tasks. We always
want more, it's human nature. Windows users
download programs from various sources, then a
double-click on the correct file does the rest. Windows
users should go to trusted sites only, and scan for
viruses as well.
With Mandriva Linux, the process is slightly different
but just as easy, once understood. For a start, there is a
huge number of programs already loaded, but of course
we want extras. Where do we get them from?
1. The Mandriva DVD version has a terrific number of
apps apart from those initially loaded, but it can never
be up to the minute, so we look for the latest online.
2. The official websites offer thousands and we can
trust them to be genuine. (It is only when you look
further afield that you need any technical knowledge.)
BROAD OUTLINE:-

called “CDROM” as DVDs and CDs are both the
same really.
If you want online sources that aren't already there you
will need to click Add. This only ever needs to be done
once - it stays done.
2. Close the ConfigureMedia page and open
Install/RemoveSoftware. A simple search tells you
what you can have, and what you need to download
to have it. Answer “Yes” if it asks your OK for
dependencies.
3. WAIT. It doesn't usually take long at all.
4. You may have to search your Menu to find where
the new menu item has been placed.
Once you know where it is in the Menu you can create
an icon if you want to. Drag&Drop onto your desktop
does the trick, but if you have any problems, ask one of
the Linux group at one of the Club venues.
UPDATES

1. Tell your PC where to look for new software.

The procedure is exactly the same, but in Step 1b you
should unmark all sources except those for Updates,
and make sure all Update sources are ticked in both
columns. Don't do an Install and an Update at the same
time.

2.
a) Ask for an app with a certain name;
b) Answer any questions asked – Yes (or No).
3. Wait till it finishes.
4. Look in your Main Menu and start up the app. (It is
rare to see an icon appear on your desktop, but they
are easy to create.)
In many cases there will be some first-time
configuration, especially with email clients and such
like. That applies to Windows users as well.
HERE IS THE DETAIL :1. 1.
a) Open MandrivaControlCentre(MCC).
If you don't have an icon for this, go to Menu >
Tools > SystemTools > ConfigureYourComputer.
Your root password is needed – you don't want
the kids installing things without your say-so!
b) In the SoftwareManagement page choose
ConfigureMedia and make sure it is set up to look
on the DVD or online or both. The DVD may be

The other difference is in Step 3 – the download/install
process can take a long time – very, very long
sometimes! If you update regularly, there will be less to
do each time.
Incidentally, the procedures above are the only time
you would go online with root privileges. Do not forget
this. It is the main difference between secure browsing
with Linux or Mac versus virus-ridden browsing from
Windows. If you browse as an ordinary user, any
underhand scripts would do no harm at all, since they
would be UNABLE TO RUN . That is why the black
hackers don't bother trying to infect Linux.
OTHER WAYS
To get the latest version of OpenOffice or some other
apps, we sometimes employ a different technique. It
becomes a bit technical, so the best way is to find a
Linux person at the Club who is comfortable doing it.

Tech Support:

'OK. In the bottom left hand side of the screen, can you see the 'OK' button displayed?’

Customer:

'Wow. How can you see my screen from there?'
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Can You Trust What You Read Online? by Deb Shinder
(This article was written by Deb Shinder in WXP News –
a free email newsletter published by Sunbelt Security
Software)
"It must be true - I read it on the Internet." That line is
nearly always sure to get a laugh as most people know
that just because someone put it on a web site, that
doesn't mean the information is trustworthy. Anyone
with an Internet-connected computer can put up any
kind of page and disseminate any kind of information or misinformation. You don't need a lot of money or,
with today's user-friendly HTML editing tools, any
special talent or technical skill to do it.
I am old enough to still remember the days when, if
you read something in the newspaper, you could be
reasonably sure it was probably accurate. That was in
the olden days when publications carefully vetted their
reporters and employed fact-checkers to verify
information before it went into print, and (most)
journalists prided themselves on adhering to a code of
ethics.
Now, before I get inundated with messages from
readers reminding me that 'yellow journalism' has been
around for a long time (in fact, the term originated
during the 1800s when Joseph Pulitzer and William
Randolph Hearst were competing for circulation), I'm
well aware of that.
Nonetheless, publishing a
newspaper was a relatively costly endeavor and
publishers had a lot invested in their reputations, so
they were arguably at least a little more careful about
what they published. And if they weren't, they were
held accountable because their identities were well
known.
Today, much of the information on the Internet is
published anonymously, or collaboratively (as with
wikis) where the original author's material may be
edited and changed many times by other people.
Wikipedia is a good case in point; it's the place where
many casual Internet users turn first to look up an
overview of a subject, but it's also dismissed in many
circles as unreliable and full of inaccuracies. Wiki
technology is useful for creating collaborative projects,
but since anyone can contribute an article - or edit or
delete the articles written by others - those with a
political or personal agenda can use the wiki's openness
to purposely or unintentional propagate falsehoods.
Many schools frown on the use of Wikipedia and other
wikis by students as sources for papers and research.
Here's what one college has to say on their library's
web page: "Because anyone can add or change
content, there is an inherent lack of reliability and

stability to Wikipedia. Authors of articles may not
necessarily be experts on the topics they write about,
leaving a lot of room for errors, misinformation, and
bias."
While academic institutions have been wary of wikis,
the tech community has been quicker to adopt the
format. Microsoft is beta testing the TechNet Wiki, a
forum where IT professionals can post articles on
Microsoft technology and edit those that others post.
It's a total departure from the way TechNet content has
been published in the past - a long editorial process
that includes detailed reviews and edits before the
article ever makes it to the web site.
The concept of the wiki is the same as that behind
open source software: that by allowing anyone to make
changes, you create an environment where any errors
in the original will be quickly identified and corrected by
the community, and that it will naturally evolve into
something better. In a perfect world, it would indeed
work that way. But in the real world, Linux - the most
popular open source desktop operating system - has
managed to garner only about 2% of the global market
share, despite the fact that it can be had for free. Is
that because it's too hard to use, because people don't
trust it, or because the open source model tends to
result in a rather chaotic situation whereby there are so
many different versions and iterations that people get
confused?
Now, it takes a certain amount of knowledge and skill
as a programmer to modify an operating system.
Modifying written information only requires literacy in
the English language (or whatever language the
information is published in). There is no guarantee that
the person(s) making the modifications have any
expertise in the actual subject matter at all. So trust
may be a bigger issue with written content than with
computer code. Chaos and confusion are very real
potential drawbacks of relying on "wikified" information,
too.
I've seen numerous Wikipedia articles that,
because of partial editing, contained conflicting "facts."
Of course, the wiki approach can save a company
money that would otherwise be spent to pay
professional writers - and that's one of the big
attractions from the publisher's point of view. But
professional writers make their livings that way, and
many of them don't have the time nor inclination to
contribute much, if any, to an unpaid wiki.
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Continued from Page 6
WHAT NEXT?

Anyway, I advised her to come up with a phrase or a
combination of things she could easily recall and
condense them into upper and lower case letters, some
numbers, and a character or two to connect them. After
some time goes by and she might want to change it,
simply start remembering something different.
Another way to build a middle level password is
to take two words you can remember and
combine them. Mickey & Donald become

With winter almost upon us here is a gift idea
for that computer geek who has everything!
USB Heating Gloves!!
These wool gloves with heating elements inside
have two heat settings and can rise ten degrees
in five minutes, making sure your hands are
toasty warm

Mdiocnkaelyd&
Very Strong Passwords are completely random
and never contain any word found in the
dictionary. They contain letters, numbers, uppercase letters and symbols.
Example: E78++uetP8
That was my advice. Do you have a method to
the madness of remembering passwords that
you could divulge? (Without giving anything
away, of course.)

Continued from Page 8
But let's put the money issue aside for a moment.
Professional writers also take pride in their work and
most have some emotional investment in it. Are pros
going to write articles that any and everybody can
come along and change at will?
Sure, professional writers are used to working with
editors who make changes but in most cases, the
writer still has a lot of control over the final product
and an important point is that in the typical
professional writing project, there is a final product.
Once the edits have been done and the compromises
have been reached, the articles goes into print or up on
the web and the author doesn't have to worry about
checking it every week to see if someone has changed
it and introduced inaccuracies. Certainly, if it's online it
can be easily updated or any errors that get through
the editing process can be changed, but it's not a
"living document" that can turn into something
completely different without the author's knowledge.
So if professional writers have little incentive to write
for a wiki, who will contribute to something like the
TechNet Wiki?
Microsoft could have their own
employees write the articles - but if those articles can
then be changed by everyone, will readers be able to
trust the content? It's technically possible to "lock
down" the content so that it can't be edited - but then
is it a wiki anymore?

One advantage of the Wiki over much of the other
TechNet content is that it does give the author a byline,
so that whoever writes the article gets credit - and
accountability. I prefer knowing who wrote a particular
piece to the anonymous papers and articles that are
seemingly written "by Microsoft" (or any other
company). The issue of reputation is an important one
- in both the security world and in the world of
information dissemination. I want to know whom I'm
dealing with - that way, I can use historical information
(whether that author has provided accurate and
reliable info in the past) to help me judge whether to
trust the current content. And as an author myself, I
like to "own" what I write - there is much more
incentive there to make double and triple sure that
everything in it is accurate and that it's as well written
as I can make it.
What type of online content do you trust most? When
it comes to technical matters, do you want
authoritative documentation from the vendor or a
recognised expert, that can't be changed by others
whose credentials are unknown? Or do you think we
end up with more comprehensive and more accurate
information in the long run if we let everybody chime
in? Do you trust what you read in Wikipedia or other
wikis, or do you take it with a grain of salt? Do you
distrust all online content? Is it inherently less reliable
than printed content? Or can you believe anything you
read anymore?
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Open Office Tips by Jean Lear
Open Office Extensions

OPEN OFFICE CALC (SPREADSHEETS)

Like Firefox, OpenOffice also comes with extensions
that can be used to improve its functionality. The site http://extensions.services.openoffice.org/application
lists Extensions. At this page it is possible to view All
Extensions or view them as applicable to the various
Applications in Open Office (e.g. Writer, Base, Calc,
Draw etc) or by the Highest Rated, Most Popular, Most
Recent etc. People 0904 all over the world create these
extensions and then provide them for all users of Open
Office so it is not uncommon to find extensions that are
in a foreign language. The site includes instructions on
installation of extensions as does the Help Files in the
Open Office applications.

ADDING BACKGROUND
SECOND LINE

Colour Two Rows
http://extensions.services.openoffice.org/node/1039
This extension enables rapid colouring table rows with
different colours to selected or used areas. Once the
extension is installed an icon called 'Two colour row' will
appear on the tool bar. Open an Open Office Calc
document and highlight a number of cells. Click on the
Icon and Color2Rows Window comes up. Here choose
the colours from the drop down list for the lines inside
the listing fields and click 'Performing' On a filled table
choose a starting point in the table, e.g., A1 and the
programme will automatically recognize the end of the
used table section. Additionally the column titles can
automatically be formatted as bold and/or centred
using the Options Columntitle part of the window. If
the table does not have column titles, there is the
ability to not choose this feature. The last check box
selection and the last colour selection is automatically
saved.
To make changes to the selections made
highlight the cells and the 'Two colour row' icon and
change. To remove all colours highlight the cells and
then >Format > Cells > Background > No Fill > OK
One disadvantage to this extension is that if a row is
deleted after the colours have been set up the colours
do not change to cope with the deletion. The work
around would be to delete the colours as set for the
whole document and then redo. The alternative with
the limitations of adding colour to every second line
(See separate article) copes with the deletion or
addition of rows and automatically changes the whole
document. The choice is to use the method thought to
be best suited to your needs.

COLOUR

TO

EVERY

If working on a spread sheet there can be advantages
to have each second row shaded in
a particular colour throughout the sheet. This will stay
constant even if rows are deleted or added to the sheet
during work on it.
Open Open Office Calc - Select any single cell within
the sheet to format it with the colour required. Go to
Format > Cells > Background > click on colour required
> click on OK
Next step is to give that format a name. Go to Format
> Styles and Formatting > In the Styles and Formatting
Window > click on the 'New style from Selection' Icon
(the middle icon at the top right hand corner of the
Window. In the 'Create Style' Window > Style name >
insert a name of the colour to identify the background
chosen > click OK. This inserts that name in the list on
the Style and Formatting Window. Close the window by
clicking on the 'X' in the top right hand corner. Go back
to the Spreadsheet and take the format off the chosen
cell. (Format > Cells > Background > choose No Fill >
click OK)
Select all cells in the spread sheet either 'Ctrl + A' or
Click the blank cell in the top left hand corner of the
spread sheet at the intersection of the row and line
number. Now apply conditional formatting to the entire
sheet. Go to Format > Conditional Formatting.
In the Conditional Formatting Window > tick the
Condition 1 box > in the spin box below that, change to
'Formula is' In the box opposite this type in formula “
mod(row()+1;2)=1” without the inverted commas. In
the Cell Style from the drop down choose the colour
there that was chosen previously for the spreadsheet.
Click OK. Take the highlighting off the spread sheet
and every second row will be the chosen colour. If
intending to use this regularly on new spreadsheets
save as a Template.
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Bits and Pieces - by Jean Lear
Online Conversions
http://www.convert.net
Convert.net is an online conversions calculator
for a variety of unit measurements featuring
natural language queries for
Measurements,
Temperature, Time Zones, Cooking, Calculator.
You can use Convert.net to sum up a list of
numbers, convert from pounds to kilograms, or
evaluate any other mathematical expression.
Convert.net
can
evaluate
mathematical
expressions involving basic arithmetic, advanced
math and logic, and conversions of a large
number of unit measurements in different fields.
Also on this site are links to other information
sources such as Abbreviations, Definitions,
Phrases, Quotations, References, Rhymes and
Synonyms. Each of these pages is divided into
categories to simplify searching and with search
boxes for narrowing down search results. Also
some allow browsing alphabetically.

E Mailing - Using BCC and CC
When sending an email, some people place all
the email addresses in the To: field. There are
two drawbacks to this practice:
1.

the recipient knows that you have sent the
same message to a large number of
recipients, and

2.

you are publicising someone else's email
address without their permission.

One way to get round this is to place all
addresses in the Bcc: field. However, the
recipient will only see the address from the To:
field in their email, so if this was empty, the To:
field will be blank and this might look like
spamming. You could include the mailing list
email address in the To: field, or even better, if
you have Microsoft Outlook and Word you can do
a mail merge and create one
message for each recipient. A mail merge also
allows you to use fields in the message so that
you can for instance address each recipient
personally. For more information on how to do a
Word mail merge, consult the Help in Word.
Use cc: field sparingly.

of the message. Using the cc: field can be
confusing since the recipients might not know
who is supposed to act on the message. Also,
when responding to a cc: message, should you
include the other recipient in the cc: field as
well? This will depend on the situation. In
general, do not include the person in the cc: field
unless you have a particular reason for wanting
this person to see your response. Again, make
sure that this person will know why they are
receiving a copy.

Mobile Telephones - T9 Text (Predictive
Text) Solutions
What is T9? T9 stands for "Text on 9 keys". It is
software that comes preloaded on many mobile
devices to make it faster and easier to type text
on numeric keypads. T9 Text Input has been
licensed by nearly all of the world's leading
mobile phone manufacturers. Today more than
800 mobile phone models around the world are
equipped with T9 Text Input capabilities. T9
unlocks the power of mobile phone keypads
letting you enter messages faster and easier.
Visit
http://www.mobileburn.com:8080/pressrelease.js
p?Id=8402 for general information about T9, and
www.nuance.com/t9/ for an overview of T9
solutions. Here there are links to T9 Text Input, XT9 Smart Input, T9 Navigation,
T9 Write, T9 Output, T9 Trace.
By clicking the 'More' on the T9 Text Input
section the next page has a T9 Text Input Demo
with 'View a Demo' which can be followed
through by mouse clicks to enter text etc
through the telephone keypad.
This should clear up some of the confusion for
some of those members who attended the
recent Telstra training Sessions 'Learn How to
use your Mobile Telephones' particularly
regarding the understanding of T9 Text. Not all
of the demonstrations were covered in the
Telstra sessions. With the number of different
Mobile telephones in use be aware your mobile
may not be able to be used in the same manner
as the demonstrations but the site should clarify
some points.

Try not to use the cc: field unless the recipient in
the cc: field knows why they are receiving a copy
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Continued from Page 5
You can resize or move the text box or even delete it
and replace it with a callout or fontwork gallery or any
of the other tools available to you from the bottom of
your Impress screen.
You will also find a very useful option in the context
menu accessed from the border of any of your screen
items - it is "Interaction". This will allow you direct the
behaviour if the item when it is clicked on.

transitioning from one slide to the next. There are
many to choose from, but my advice is that unless the
transition really adds to the story of your presentation
either don't use them or stick to one style for the
complete presentation. Just because you can, doesn't
mean you should!
This is where you can also select background music to
play throughout your presentation, or until you select
another piece of music.
When you want to add the next slide select from the
menu bar Insert/Slide or Duplicate Slide. Inserting a
new slide will give you a slide with the background and
the layout in place while a duplicate slide will give you
an exact replica of your edited slide. This is what I did
for the ABC game.
If you want to have a play with the ABC game you can
download
it
(6720kb)
from
http://www.sccc.org.au/bnb/abc.odp. This game is
completed to the letter L and it also has a "The End"
page. You just need to duplicate the letter L or 13th
slide and change the content.

I did not use the next two tabs in the Task pane as
they were not required for my presentation. They are
Table Design and Custom Animation. These can be
discussed at a later date.

Have fun!

The final tab is Slide Transition. As the name suggests
this is where you can select different effects for
Find Your Membership Number
Congratulations to Chris Rowland who found his membership number
hidden in the May 2010 edition of Bits'N'Bytes. He was allocated 5 free
tickets in the current club raffle.
Do you read your Bits'N'Bytes each month? Find your membership
number hidden somewhere in one of the pages and win five free
tickets in the current raffle.
The membership number will be chosen at random and will appear as a four digit number within the text of
the magazine and may be on any page. If your membership number has 1, 2 or 3 digits, it will be shown
with leading 0s.
Do not forget to thoroughly scrutinise every magazine for your membership number hidden within
the text of articles each month.
The number is placed in the 8672 middle of a sentence like this!
Start looking now! The lucky membership number is hidden somewhere in this month's edition. Is it
yours?
When you find your number contact the club by email at editor@sccc.org.au or phone 54921005
to claim your prize. You are allowed 60 days from the publication date to claim your prize.
Otherwise, the prize is forfeited!
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Chocolate Calculator
YOUR AGE BY CHOCOLATE MATHS
1. First of all, pick the number of times a week that you
would like to have chocolate (more than once but less than
10)
2. Multiply this number by 2 (just to be bold)
3. Add 5
4. Multiply it by 50 -- Go and get the calculator
5. If you have already had your birthday this year add
1760 .. If you haven't, add 1759..
6. Now subtract the four digit year that you were born.
You should have a three digit number
The first digit of this was your original number
(i.e., how many times you want to have chocolate each
week).
The next two numbers are YOUR AGE! (Oh YES, it is!!!!!)

Corporate Members

Help with Computers

Peter Daley

Andrew Hadland Diploma ICT
Phone 5491 8645
•
•
•
•
•

Help with all aspects of Computer
Functions
Tuition – Emails – Scanning – Video
Editing
Burning CD's / DVD's – Backups
Protection Anti Virus – Spyware – Firewall
Internet – ADSL Setup

Computer Repairs and Upgrades for Windows
and Linux. Data Recovery, Computer and
Internet
Training
and
Setup.
Home
Entertainment and Hi Fi systems setups and
advice. Custom built computers, all computer
systems are tested before pickup. Award
Winning Web Page Designer!
E-mail: ( Peter Daley)...

PH 0754913279
| Free Books | | Links | | E-mail |

Computer - Repairs - New Systems

Welfare Officer
Sunshine Coast Computer Club
Phone 54925443 Email
gregalach54@westnet.com.au
If you are ill or incapacitated or know of a club
member who needs some assistance or would
like to hear from the Club
contact our Welfare Officer Marie McGregor
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Classified Ads
Classified Advertisements in Bits'N'Bytes - Editorial Policy is that B'N'B Classified Advertisement 1. Are for the use of members only.
2. Items must not be of a business or commercial nature.
3. Items submitted should be limited to a few items - no huge garage sale lists please!
4. Items should preferably be relevant to computers, graphics, video, audio, electrical or
electronic hobbies etc. Adverts for other types of household goods will be accepted only if
there is sufficient room for them.
5. Ads should preferably be forwarded direct to editor@sccc.org.au or phoned in to 54913279.
6. The Editor reserves the right to reject or edit any material .

FOR HIRE OR LOAN

FOR SALE

The Sunshine Coast Computer Club owns data
projectors, laptops, external DVD burners,
scanners, digital cameras, etc.

Thomson SpeedTouch 536
ADSL2+ Gateway DSL Modem
•
•
•
•
•

This equipment is available for hire or loan to
members when it is not required by the club for
meetings and presentations.
Contact your club if you need to borrow or hire
equipment.

•

Email: sccc@sccc.org.au
Telephone: 0754921005

ADSL2+ connection to the Internet
1x Ethernet port
1x USB slave
Firewall
NAT connection sharing including helpers
for most popular protocols (SIP,
RealAudio, etc.)
VPN support

Seller will give technical assistance to install this
modem on any broadband provider.
$30
Heinz Bienholz
Telephone 07 54501917

Place Your Classified Ad on this page.
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CDs Available from SCCC Inc.

Please Print : Name(First)............................................(Last)..............................................................
Address..............................................................City...............................................Post Code.............
Item (Prices include GST)

Number

Club CD - Packed with free software, games and books.

@ $10 each

Bits'N'Bytes Ezine Archives CD - June 1998 to December 2009.
Bits'N'Bytes Ezine Archives CD – trade in your old copy.

@ $10 each
@ $5 each

Multimedia CD - Clip Art, Animations, Midi and Wav files and
background colours to add to cards, emails etc.
Multimedia CD Upgrade (With old version CD returned)

Cost

@$10 each
@ $5 each

Postage (for one or more CDs)

$3.00

Post to : SCCC, Post Office Box 384, Caloundra
Enclosed
Cheque / Money Order / Cash

4551

Total

Surf Watch - Members Web Sites...Submit Yours

Member
Peter Daley

Very Useful Links
http://www.ozemail.com.au/~vital1/lstlinks.htm

Peter Daley

Fantasyland Creations http://www.ozemail.com.au/~vital1/

Peter Daley

Daley Positive Personal Development
http://www.ozemail.com.au/~vital1/freebks.htm

Jay Leboutillier

Website Design Centre http://www.websitedesigncentre.com.au/

Technologypals

Corporate member http://www.technologypals.com.au

Bill Maxwell

IT Knowledge Base for Seniors http://it.flexinet.com.au/

Richard Philippe
(Aka Richi Who)

Be Master of Your Life http://www.personal-development-course.com
Richi Who's http://www.psychic-mystic.com

Mathew Carter

Free Online Photo Community http://fotoforfree.com.au

Club Intranet
The Club Intranet is available at all meeting venues. It is packed with up to date free software, tutorials and back
issues of Bits'N'Bytes. Access it from any networked computer at the venue.
Type In your browser address bar:
192.168.2.222 (If you are at Buderim) or 192.168.0.222 (If you are at Caloundra or
Yandina)

Your Committee
President
Vice President
Secretary
Treasurer
Administration Co-ordinator
Committee
Committee
Committee
Committee
Committee
Committee
Committee

Peter Daley
Tony Tasker
Marie McGregor
Heather Atkinson
Jean Lear
Tom Bray
Morry Phillips
George Lupsa
Jim McGregor
Ian Smyth
Andrew Hadland
Don Wallace
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5491 3279 (VOIP)09134402
5476 7129
5492 5443
5444 0886 (VOIP)09110928
5492 1151
5479 3149
5491 1148
5445 3850
5492 5443
5491 9139
5491 8645
0401093692
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SCCC Membership Application/Renewal Form
Applications can be posted to SCCC Inc., P O Box 384, Caloundra, 4551
or presented at a meeting
I wish to apply for membership
I wish to renew my membership

Name(s):

Address:
City:

Postcode:

Phone:
Email:
I will collect my membership card from Caloundra

Buderim

Membership fees include the electronic version of the club
magazine.

Yandina

Amount

Individual

$35

Family

$45

Corporate (Includes a monthly advertisement in the club magazine)

$60

Junior (Under 18 Years of Age)

$20

For the additional cost of $12 you may subscribe to a printed and posted
paper version of the club magazine.
Magazine subscription

$12
Total Enclosed $

Signature:
If after joining you don't receive your magazine within one month,
please contact the Club.
SCCC Office Use
Date Paid:

Amount: $

Receipt Number:

Membership Number:

Signed:

Nominated:
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